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Introduction 
 

This design example book provides a comprehensive guide for RC design as per Eurocode2-1-1:2002. Specifically, 
this guide will review the design algorithms implemented in midas Gen, and go through design tutorials. This book is 
helpful in understanding the Eurocode design concept and verifying design results using midas Gen. 

 

 

 
This chapter describes the main features and advantages of midas Gen and showcases 
prominent project applications.  
 
 
 

 

 

 
This chapter discusses the general design concept of EN1992-1-1 and how it has been 
implemented in midas Gen. T his enables the user to understand the equations, 
formulas, program  limitations and deve lopment scope of the  midas Gen design 
features. 
 
 

 

 

 
This chapter enables the user to get acquainted with the RC design procedure in midas 
Gen as per EN1992-1-1: 2004. It encompasses the overall design procedure, from 
generating load combinations to checking design results with updated sections. 
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1.1 Design Scope 
midas Gen provides automatic design of concrete beam, column, shear wall, meshed slab and 

meshed wall. The program also supports section checking when relevant data is specified. With 
respect to Eurocode, the major capabilities of the program can be summarized as below: 

 Ultimate Limit State and Serviceability Limit State design and checking 

 Auto generation of load combinations as per Eurocode 1990:2002 

 Auto generation of Static Wind Loads as per Eurocode 1991-1-4:2005 

 Auto generation of Static Seismic Loads & Response Spectrum Functions as per Eurocode 

1998-1:2004 
 Capacity design as per Eurocode 1998-1:2004 

 Available Section shapes for design: 

o Beam: Rectangle, T-shape 
o Column: Rectangle, Circular, Hollow circular 

o Wall: Rectangle 
 Design and checking of meshed slab and meshed wall  

 Cracked section analysis of slabs for serviceability checks 

 
The following should be taken care of by the user: 

 Torsion check is not provided by midas Gen. 
 Irregular wall such as L or H shape cannot be designed. 

 Isolated footing design is not supported as per EN 1992-1-1:2004. 

 

 
This design guide covers the design of frame elements as per EN 1992-1-1:2004 for non-seismic 
situations. Aspects of column design, beam design and wall design are discussed in this guide. 

For the purpose of component design, midas Gen interacts with midas Design+. midas Design+ is a 

collection of handy structural component design and detail ing tools, which are easy to use and speed 
up the day-to-day design process. midas Design+ is developed to be s imple, fast and accurate. It 
enables engineers to systematically and consistently manage design reports. midas Design+ supports   
Column design, Wall Design and Strip Footing Design as per Eurocode. 

 

 

[Table 1.1] Capabilities of midas Gen with respect to Eurocode 
 Ultimate Limit State Serviceability Limit State 

 Flexure Shear Axial Torsion Stress Deflection Crack Control 

Beam        
Column        

Wall         

Meshed Slab        
Meshed Wall         

 

 

1.2 Materials 
1.2.1 Concrete 

EN 1992-1-1:2004 (Table 3.1) provides specifications about strength and deformati on characteristics 
of concrete. midas Gen supports a material database as per the specifications. Any of the materials 

can be easily chosen for analysis as well as design. The following are the strength classes of concrete 
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as identified by the code: 
 C12/15 

 C16/20 

 C20/25 

 C30/37 

 C35/45 

 C40/50 

 C45/55 

 C50/60 

 C55/67 

 C60/75 

 C70/85 

 C80/95 

 C90/105 

Material name C40/50 implies that the cylinder characteristic strength (fck) at 28 days is 40 MPa and 
cube characteristic strength (fck,cube) at 28 days is 50 MPa. 

 
The material can be chosen in Material Data dialog Box as shown below. In dialog box, choose Type 
of Design as “Concrete”. Standard as “EN04(RC)”. Then from DB drop down list any of the above 
materials can be chosen. 

 
 

1.2.1.1 Modulus of Elasticity (Ec) 
For materials selected from EN 1992-1-1:2004, the modulus of elasticity is obtained using the 
formula as specified by the code: 

𝐸𝑐𝑚 = 22 (
𝑓𝑐𝑚

10
)

0.3

                                                              (1.1) 

 
𝑓𝑐𝑚 = 𝑓𝑐𝑘 + 8 (MPa)                                                            (1.2) 

 

Note for Italian users 

For Italian user, the program supports the UNI material database. The database includes the 

following materials: 

 Rck 10 

 Rck 15 

 Rck 20 

 Rck 25 

 Rck 30 

 Rck 35 

 Rck 40 

 Rck 45 

 Rck 50. 

For these materials, the user needs to choose the Standard as “UNI(RC)” and then select the desired 

material. 

 

 

1.2.1.2 Poisson’s Ratio 
The default value of Poisson’s ratio is used as 0.2. For a different value of Poisson’s ratio user defined 

material needs to be specified as per Section 1.2.1.4 of this guide. 
 
 

1.2.1.3 Weight Density 
The weight density is used as 25 kN/m3 for all  the material from the database. For a different weight 
density user defined material needs to be specified as per Section 1.2.1.4 of this guide. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
EN1992-1-
1:2004 
Table 3.1 
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 Model > Properties > Material 

 
[Figure 1.1] Material Data dialog box 

 
 

1.2.1.4 User Defined Materials 
User defined Concrete Material can be specified. Type of Design should be used as Concrete, 
otherwise the design cannot be performed for the specified material . Then select the Standard as 
None to input the user defined material properties. Type of design should not be selected as User 

Defined. 

 

1.2.2 Reinforcement 

The reinforcement material can be specified in Modify Concrete Materials dialog box as shown in 
Section 1.2.3. If the material is not specified there, then the default material will  be taken as specified 
in Design/Load Code Environment in Tools > Preferences. Then under Concrete heading user can 

specify the database for Rebar. The available rebar materials as per Eurocode are as follow: 

[Table 1.2] Ava ilable Rebar Materials as per EN 1992-1-1:2004 

Rebar Materia l  Yield Strength (fy) (MPa) 

Class A 400 

Class B 500 

Class C 600 
 

Note for Italian users 

For Italian users, the program supports the UNI database consisting of the following materials: 

 FeB22k 

 FeB32k 

 Feb38k 

 Feb44k 

To select the above materials, we need to specify the Material Code as “UNI(RC)”. 
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 Tools > Preferences 

 
[Figure 1.2] Preferences dialog box 

 

1.2.2.1 Modulus of Elasticity (Es) 
For all  the reinforcing materials, modulus of elasticity is used as 200 GPa. Different value of Modulus 
of Elasticity cannot be specified for reinforcing materials . 
 

1.2.3 Design Strength of Materials 

1.2.3.1 Design compressive strength of concrete (fcd) 
The code specifies the following equation for the calculation of the design compressive strength: 

𝑓𝑐𝑑 =  
𝛼𝑐𝑐𝑓𝑐𝑘

𝛾𝑐
                                                                   (1.3) 

where, 

fck: If standard material is used, the value is taken automatically as specified in the code . For a 
user defined material, we need to specify the fck in Modify Concrete Materials dialog box shown 

below. 

αcc: Coefficient to account for: 

1. Long term effects on the compressive strength 

2. Unfavorable effects resulting from the way the load is applied. 

It can be specified in the Partial Safety Factor for Materials dialog box as shown in Section 

1.2.3.4. 

γc : The partial safety factor for concrete. It depends on the design situation. It can be specified in 
the Partial Safety Factor for Materials dialog box as shown in Section 1.2.3.4. 

 

1.2.3.2 Design yield strength of reinforcement (fyd) 
The yield strength specified for reinforcing material will  be used to calculate the design yield strength 
as per the following specification of code: 

𝑓𝑦𝑑 =  
𝑓𝑦𝑘

𝛾𝑠
                                                                    (1.4) 

where, 

fyk: The characteristic yield strength of reinforcement. 

γs : The partial safety factor for steel. It depends on the design situation. It can be specified in the 
Partial Safety Factor for Materials dialog box as shown in Section 1.2.3.4. 

 
 

 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
EN1992-1-
1:2004 
3.1.6(1) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
EN1992-1-
1:2004 
3.1.6(2) 
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 Design > Concrete Design Parameter > Modify Concrete Materials 

 
[Figure 1.3(a)] Modify Concrete Material dialog box 

 

In the above dialog box, the concrete and rebar material properties  can be specified for design. 

If standard material is used, the value is taken as specified in the code. In that case, this step is not a 
mandatory step. If material is user defined, then select 'None' in the Code field and enter the name 
of material to be used in the Name field. Then, each data field is activated and the strength of 

materials can be entered. 
Lightweight Concrete Factor (Lambda): This is irrelevant for design as per Eurocode. 
Grade of Main Rebar: The material specified here will  be used for the longitudinal reinforcement. 

Grade of Sub Rebar: The material specified here will  be used for the stirrups. 
 

 Design > Concrete Design Parameter > Modify Concrete Materials> … 

 
[Figure 1.3(b)] Short/Long Term Elasticity Ratio dialog box 

 

 

1.2.3.3 Short/Long Term Elasticity Ratio 
For serviceability check as per Eurocode 2, the ratios of the modulus of elasticity of reinforcement 
to the modulus of elasticity of concrete for short-term and long term can be entered. 
The default value for short-term ratio is Es/Ec and 2(Es/Ec) for long-term ratio. 
The ratio can be edited in the Modify Concrete Materials Dialog Box. The button next to the Name 

field, provides access to the Short/Long Term Elasticity Ratio dialog box. 
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1.2.3.4 Partial Safety Factors for Materials 
 Design > Concrete Design Parameter > Partial Safety Factors for Material Properties 

 
[Figure 1.4 Partial Factors for Material Properties dialog box] 

 

[Table 1.3] Recommended Values of Partial Safety Factors for Materials  

Des ign Si tuations  γc γs 

Persistent & Transient 1.5 1.15 

Accidental 1.2 1.0 

 
As per EN1990:2002, design situations are classified as: 

a. Fundamental Design Situations: 
1. Persistent Design Situations 

Relevant during design working life of structure 

2. Transient Design Situation 
Relevant for a shorter duration. eg: execution or repair  

b. Seismic Design Situation 
Relevant during the earthquake 

c. Accidental Design Situation 
Exceptional conditions l ike fire events, explosions, blast etc. 

Specification 5.2.4(2) of EN1998-1:2004 “If more specific data are not available, the values of the 

partial factors γc and γs adopted for the persistent and transient design situations should be applied”. 
midas Gen uses the same values of γc and γs for all  three design situations i.e Persistent, Transient & 
Seismic Design Situations. 

 

The design situation is identified automatically by the program as per the following table: 

[Table 1.4] Classification of Design Situations 

Des ign s i tuations  Description 

Fundamental and 

Seismic 

Load combinations not covered in “Accidental Situation” 

Accidental  Load Combination including any of the following type of 

load case, will  be classified in Accidental Situation: 
Live Load Impact (IL) 
Collision Load (CO) 

 

 

Load Case type is specified in the dialog box below: 
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 Load > Static Load Cases 

 
[Figure 1.5] Static Load Cases dialog box 

 

After identifying the design situation respective partial safety factors for materials are used by the 
program in design. 

 

1.3 Design Information 
1.3.1 Member Assignment 

The program offers to consider a number of l ine elements as a single member  for the purpose of 
design. The design forces and the section capacities will be calculated at the i, ¼, ½, ¾, j-point of the 
member and not of the element. Also, the span for the design will  be considered as per the 
specifications of the member and not of the element. 

 
The unbraced length will  be taken on a member basis, instead of element basis. Laterally Unbraced 
Length is taken from the member. 

 
[Figure 1.6] Unbraced Length for column 

 

If the elements to be assigned to a member retain different material and section properties, or the 
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directions of the node connections are different, a member cannot be assigned. 
 

 Design > General Design Parameter > Member Assignment 

 

 
[Figure 1.7 Member Assignment dialog box] 

 
 

1.3.2 Unbraced Length 

When members are defined by Member Assignment, unbraced lengths about the member ’s strong 

axis (y-Axis) and weak axis (z-Axis) are automatically calculated by the program considering the 
connectivity of the members. 
If members are not defined then the unbraced length is taken equal to the length of the element for 
bending about both axis. 

 
The unbraced length can also be specified by the user in Unbraced Length dialog box as shown 
below. If unbraced length is specified as 0, then progra m will  take the unbraced length as the length 

of the member or the length of the element, whichever is applicable. 
 

 Design > General Design Parameter > Unbraced Length 

 
[Figure 1.8] Unbraced Length dialog box 

 

 

1.3.3 Live Load Reduction Factor 

When calculating the Forces for design, the effect of l ive load can be reduced. Axial force, moments 

and shear forces due to actions can be reduced. The reduction factor can be specified in the Modify 
Live Load Reduction Factor dialog box. In order to specify the live load to be reduced to 80%, the 
factor of 0.8 should be added for the respective forces. 
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 Design > General Design Parameters > Modify Live Load Reduction Factor 

 
[Figure 1.9 Modify Live Load Reduction Factor dialog box] 

 

The live load reduction factor needs to be calculated manually. The formula specified by EN 1991-1-
1:2002 is: 

𝛼𝑛 =  
2+ (𝑛+2)𝜓0

𝑛
                                                                (1.5) 

where: 

n is the number of storys (>2) above the loaded structural elements from the same category. 

Ψ0 is the factor for combination of variable actions. It is provided in EN 1990, Annex A1, Table 

A1.1. 

 

1.3.4 Imperfections 

Eurocode 1992-1-1:2004 specifies that the unfavorable effects of possible deviations in the geometry 
of the structure and the position of loads shall be taken into account in the analysis of members and 
structures. The imperfections should be modelled manually by the user. 

In order to consider the effect of these imperfections, the code provides equivalent transverse forces 
for these imperfections in Section 5.2 using equations from 5.4 to equation 5.6. These forces need 
to be calculated and applied manually by the user. 

 

1.3.5 P-Delta Analysis 

The amplification of the moments due to second order effects is specified by the code. Second order 
effects due to both the change of geometry of structure (P-Δ) and the curvature of member (P-δ) 

need to be considered. 
The second order effects can be easily considered in the program by performing P-Delta Analysis. 
The program performs both P-Δ as well as P-δ analysis. The corresponding magnified moments can 

be used for the design of the members. In case the P-delta analysis is not performed, the provisions 
of code will  be used to obtain the second order moments . The method of moment magnification as 
per Eurocode 2 will  be discussed in Section 2.2. 
 

 
 
 
 

 
 
 

 
 
 
 

 
 
 

EN 1991-1-
1:2002 
6.3.1.2(11) 
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 Analysis > P-Delta Analysis Control 

 
[Figure 1.10] P-Delta Analysis Control dialog box 

1.3.6 Pattern Loading 

At the moment, the program doesn’t support the auto generation of the pattern load combinations. 

 

1.3.7 Selection of Design Code 

The design code can be selected in the Concrete Design Code dialog box as shown below: 
 

 Design > Concrete Design Parameters > Concrete Design Code 

 
[Figure 1.11] Concrete Design Code dialog box 

 

In addition to the recommended values, the program supports the following National Annexes 
for design: 

 Italy 

 Sweden 

 Singapore 
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2.1 Design for flexure without axial force 
2.1.1 Requirements 
Moment capacity of the section (MRd) should be greater than the design moment for the section 
(MEd). 

To satisfy l imit state of moment resistance the following condition should be met: 
MEd≤MRd  

 

2.1.2 Calculating the moment capacity, MRd 
The distribution of strain and stresses in the section is as follows: 

 
[Figure 2.1] Distribution of strain and stresses in the section 

 
where, 

λ: factor defining the effective height of the compression zone. 

η: factor defining the effective strength of concrete. 

x: distance of the neutral axis from the extreme compression fiber 

 

To calculate the moment capacity Cc, Cs and Ts are required. In order to determine all  these forces 
depth of the neutral axis, x, needs to be calculated. 

For this, an iterative process is used. The following steps are involved in the iteration: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  
 
 

 
 
 

 
 

 
 
 

 
 
 

 
 

 
 
 

 
 
 
 
 
 
 

 
 
 

 
 
 
 
 

 
 
 

 
 

 
 
 

 
 
 

 
 
 
 
 

 
 
 
 
 
 
 

Yes 

Assume neutral Axis depth, x 

Calculate Cc (concrete compression) 

Calculate Ts (tension in steel) 
Calculate Cs (compression in steel) 

Cc + Cs = C ; Ts = T ; C-T=0 

Assumed x is the depth of neutral axis 

No 

Initial value of x=d/2 

(d = effective depth) 

Ref: 
EN 1992-1-1:2004 
Figure 3.5 
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[Figure 2.2] Flow  chart to calculate depth of Neutral Axis 

Note for design of flanged section 

For a flanged section, we need to specify the shape of the section as “T-section” in the Section 

Data dialog box. 

 

1. Determination of λ & η 

[Table 2.1] Factor for effective height of compression zone and factor for effective strength of concrete 

Condition λ η 

    fck ≤ 50MPa 0.8 1.0 

50 < fck ≤ 90MPa 0.8-(fck-50)/400 1.0-(fck-50)/200 

    fck > 90MPa 0.7 0.8 

 

2. Initial depth of the neutral axis. 

Initial depth is assumed to be d/2, where d is the distance between extreme compression 
fiber and center of tension reinforcement. 

 

3. Calculate force of concrete, Cc 

𝐶𝑐 =  𝜂 𝑓𝑐𝑑  ∫ 𝜆𝑑𝐴 𝑥                                                      (2.1) 

 

4. Calculate force of reinforcement, Ts and Cs 

𝐶𝑠 =   𝐴𝑠𝑐  𝑓𝑠𝑐                                                             (2.2) 
𝑇𝑠 =   𝐴𝑠𝑡  𝑓𝑠𝑡                                                           (2.3) 

where, 

Asc: The cross sectional area of compressive reinforcement. 

fsc: The stress at the center of the compressive reinforcement. 

Ast: The cross sectional area of tensile reinforcement. 

fst: The stress at the center of the tensile reinforcement. 

 

In order to calculate the stress of reinforcing steel, fst or fsc, the appropriate strain is 
calculated by the strain compatibility condition as follows: 

a) At the extreme compression fiber of concrete, strain equal to εcu is assumed. Then the 
strain is calculated at the center of reinforcement assuming a l i near stress strain 
distribution as per Figure 2.1. 

cu

t

s
x

xd



                                               (2.4) 

where, 

εs : The strain at the level of the reinforcement. 

εcu: The ultimate compressive strain in the concrete. (εcu = εcu1) 

x  : Neutral axis depth. 

dt : Distance of the rebar from extreme compression fiber 

 

[Table 2.2] Ultimate Strain ( εcu1) in Concrete 

Condition εcu1 

    fck ≤ 50MPa 0.0035 

50 < fck ≤ 90MPa [2.8+27{(98-fcm)/100}4]/1000, fcm=fck+8MPa 

    fck > 90MPa 0.0028 

 

 

 
 
 
 
 

 
 
 

EN1992-1-1:2004 
3.1.7(3) 

 
 
 

 
 
 

 
 
 
 
 
 
 

 
 
 
 
 

 
 
 

 
 
 

 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

EN1992-1-1:2004 
Table 3.1 

 
 
 

 
 
 

 
 



 

15 
 

CHAPTE R 2. RC Design Algorithm   

 

 
[Figure 2.3] Possible strain distributions in the ultimate limit state 

 

b) Calculate the reinforcement stresses corresponding to the calculated reinforcement 
strains. (from the stress-strain idealizations) 










)(

)(

ydsyd

ydsss

s f

E
f




                                        (2.5) 

The forces of tensile reinforcement and compressive reinforcement are calculated in the 
above manner. 

 

5. Check if the assumed depth of neutral axis is suitable or not. For this purpose, the 
convergence criteria is checked. If the following condition is met, then the assumed x is 
used as depth of neutral axis : 

|
𝐶−𝑇

𝑇
| < 0.01 (Tolerence) 

If aforementioned condition is not fulfi l led then, new depth of neutral axis is assumed by 
“Bisection Method (Numerical analysis)”. 

If the above criteria is not met after 20 iterations, then: 

 We get output “Not converge” in Message window. 

 The model needs to be modified as follows: 

o Increase section size. 
o Modify the rebar information (position, numbers, spacing, etc.)  

  

6. Calculate moment resistance MRd 

Once the neutral axis is obtained, moment resistance can be calculated by multiplying the axial 
forces with eccentricity from the neutral axis.  

MRd = Ccac + Csasc + Tsast                                                       (2.6) 

 

 

 

 

 

 

 
[Figure 2.4] Forces and distances from neutral axis depth for MRd 

 
7. Check moment resistance ratio: 

𝑀𝐸𝑑

𝑀𝑅𝑑

≤ 1 

where, 
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MEd : Design bending moment is chosen for the load combinations which are available as per 
Section 2.1.5. 

MRd : Moment capacity of the section. 

Depending on the ratio, the results are displayed in the various forms as mentioned in Section 
2.4. 

 

2.1.3 Design Criteria for Rebars 

To choose the size of the rebars which should be used for the reinforcement, the specifications 
can be provided in Design criteria for Rebars dialog box as shown below. 

The transverse reinforcement data can also be specified in this dialog box.  

 

 Design > Concrete Design Parameter > Design Criteria for Rebars  

 
[Figure 2.5] Design Criteria for Rebars dialog box 

 

where, 
dT represents the distance between center of top rebar and extreme top fiber 
dB represents the distance between center of bottom rebar and the extreme bottom fiber 
When the value of dT and dB is specified as zero, then the default value is taken as minimum of: 

I. max [Hc/10, Bc/10, 2.5”/63.5 mm] 
II. 3”/76.2 mm 
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 Design > Concrete Design Parameter > Design Criteria for Rebars > Rebar… 

 
[Figure 2.6] Rebar Size dialog box 

 
The following European rebar sizes are available: 

P5, P6, P7, P8, P9, P10, P11, P12, P13, P16, P20, P25, P32, P40. 
Maximum of 5 Rebar Sizes can be selected. 

 

The data specified above will  be applied to all  the members of a model. If the user wants to 
specify different rebar criteria for certain members then that can be specified in Design Criteria 
for Rebars by Member dialog box. For that member, information provided here will  override the 
information defined in Design Criteria for Rebar dialog box. 

 

 Design > Concrete Design Parameter > Design Criteria for Rebar by Member 

 
[Figure 2.7] Design Criteria for Rebars by Members dialog box 

 

2.1.4 Concrete checking for beams 
midas Gen is capable of both design and checking of sections. The difference in design and check 
can be explained as below: 
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If the user performs the Concrete Code Design function then based on the section size and the 
factored load, rebar data such as rebar size and spacing is determined by the program. Therefore, 
the design can be performed when the section size is  defined without rebar data. 

If the user needs to perform the strength and serviceability check for the user specified rebar 

data (rebar diameter, number of rebars and design parameters), then the user can perform the 
Concrete Code Check function. The rebar data can be specified as mentioned in the section 
below. 

 

2.1.4.1 Rebar Input for Beam Checking 

The rebar data for concrete code checking can be specified in the Modify Beam Rebar data. In 

midas Gen, both top and bottom rebar must be defined to perform concrete code checking.  
 

The data can be entered for layer 1 and layer 2 of the top and the bottom reinforcement. 

The values of dT and dB need to be specified appropriately. dT and dB cannot be specified as 
zero. 

For transverse reinforcement the rebar size, number of legs and spacing of the stirrups can be 
specified. 

 

 Design > Concrete Design Parameter > Modify Beam Rebar Data 

 
[Figure 2.8] Modify Beam Rebar Data dialog box 

 

2.1.5 Design load combinations 

The load combinations specified as Strength/Stress in the Concrete Design tab of Load 
Combinations dialog box will  be used for concrete design. The program also supports the Auto 
Generation of the load combinations as per EN 1990:2002. The limitations mentioned in the 
Section 1.3.6 are appl ied to the auto generation of the load combinations. 
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 Results>Load Combinations 

 
[Figure 2.9] Load Combinations dialog box 

 

2.2 Design for flexure with Axial Force 
2.2.1 Requirements 
For l imiting the compressive strain in concrete, the following conditions need to be checked: 

Check for Axial Force 
𝑁𝐸𝑑

𝑁𝑅𝑑
 ≤ 1 

Check for Biaxial Moment 
𝑀𝐸𝑑

𝑀𝑅𝑑
 ≤ 1 

Check for Moment about major axis 
𝑀𝐸𝑑𝑦

𝑀𝑅𝑑𝑦
 ≤ 1 

Check for Moment about minor axis 
𝑀𝐸𝑑𝑧

𝑀𝑅𝑑𝑧
 ≤ 1 

If any of the above ratios is not satisfied then the section is reported to be Not Good. 
 

2.2.2 Magnification of Design Moments 

When an element is subjected to an axial load combined with a moment, it will  deflect. This 
deflection will  increase the moment at any section in the element by an amount equal to the 
axial force multiplied by the deflection at that point. This extra moment will  cause the resistance 
of the element to be reduced below that calculated ignoring the deflections. In many practical 

situations, the effect of deflections is so small that it can be ignored. So, the program compares 
the slenderness ratio of the member with the allowable slenderness l imit in order to determine 
whether the magnification of moment is required or not. 
 

2.2.2.1 Slenderness ratio 
The actual slenderness ratio of a member is calculated using: 

ʎ = l0 / I                                                                    (2.7) 
where, 

l0 is the effective length of the member. 

i is the radius of gyration. 

 
Effective Length will  be calculated as: 
lo,y = Ky x L                                                                    (2.8) 

where, 
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L is the unbraced length as specified in Section 1.3.2. 

Ky is the effective length factor. The effective length factor can be specified as shown 

below. 

 
 Design > General Design Parameter > Effective Length Factor (K) 

 
[Figure 2.10] Effective Length Factor dialog box 

 
Effective Length factor can also be calculated by the program automatically depending on the 
information provided in Definition of Frame dialog box as shown below: 

Refer to online help for the explanation of auto calculation. 
 

 Design > General Design Parameters > Definition of Frame 

 
[Figure 2.11] Definition of Frame dialog box 

 

2.2.2.2 Limiting value of slenderness ratio 
 

𝜆𝑚𝑖𝑛 =  
𝐴.𝐵.𝐶

√𝑛
                                                                    (2.7) 

where, 

A = 1/(1+0.2ϕef). It can be specified by user. Default value is 0.7 (code recommendation) 

B = √1 + 2𝜔. It can be specified by user. Default value is 1.1 (code recommendation) 

C = 1.7 - rm.  

rm = M01/M02 

M01 and M02 are end moments of column. M02 is numerically greater of both. M01/M02 

> 0 for single curvature bending and less than 0 for double curvature bending. 

Code recommends that If rm is not known, C=0.7 may be used. Constant value of C can be 

specified. Also, the program can calculate the factor C and rm based on M01 and M02. 

n = NEd/Ac fcd. this is the normalized normal force. 
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 Design > Concrete Design Parameter > Concrete Design Code 

 
[Figure 2.12] Concrete Design Code dialog box 

 

2.2.2.3 Magnification of Moments 
The slenderness ratio, ʎ (as obtained in 2.2.2.1) is compared to l imiting slenderness ratio, ʎmin. If 
P-Δ Analysis has not been performed and ʎ > ʎmin, then the moments are magnified as per the 
specifications of the code in order to account for the second order moments. If ʎ < ʎmin or P-Δ 
Analysis has been performed, then the specifications of the code are not used to magnify the 

design moments. 
 
EN 1992-1-1:2004 specifies the following two methods of moment magnification. 

i . Based on Nominal Stiffness 

ii . Based on Nominal Curvature 
midas Gen uses Nominal Curvature Method. 
 

As per Nominal Curvature Method, the overall  design moment, MEd is computed as: 
 
MEd = M0Ed + M2                                                             (2.8) 
where, 

M0Ed = 0.6 M02 + 0.4 M01 ≥ 0.4 M02 
 
This is valid only if no transverse load exists between supports. In case the transverse load exists 

between the supports, M0Ed = M02. In that case, it is recommended to perform P- Δ Analysis. 
M2 = NEd x e2                        M2 is the additional second order moment. 

where, 

e2 = (1/r)l0
2/c                e2 is the deflection. 

l0 is effective length as specified in Section 2.2.2.1. 

c depends on curvature distribution, program uses c = 10 as recommended by code. 
The value of c cannot be changed by user. 

1/r = Kr Kφ 1/r0            Curvature 
Kr = (nu-n)/(nu-nbal)   Correction factor for axial load  

n = Ned/Ac fcd   Relative axial force.    

nu = 1 + ω     
ω = 0.105.     (Recommended) Different value cannot be specified. 

nbal = 0.4       (Recommended) Different value cannot be specified. 
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Kφ = 1              (Factor for accounting creep)  
1/r0 = ε yd/(0.45d) 

ε yd = fyd/Es 

The above calculations are performed for major and minor directions separately. 
For the wall the magnification is performed for in-plane bending. If design is also performed for 
out-of-plane bending, then the above check will  also be performed for out-of-plane bending. The 

choice of design for out-of-plane bending can be specified in Input Additional Wall Data dialog 
box. 
  

2.2.3 Determination of the Eccentric Axial Load Capacity 

The following procedure is followed to determine the eccentric load capacity of the column: 

1. Calculate the eccentricities of bi -axially loaded column: 
ecy = |MEdz/NEd| 
ecz = |MEdy/NEd| 
e = |MEd/NEd| 

Angle of axis of bending = tan-1|Ecy/Ecz| 
Angle of rotation of neutral axis  at the ultimate limit state is determined by the program. 
 

 
 
 
 

 
 
 
 

 
[Figure 2.13] Forces and Moments on a member w ith eccentric axial load 

where, 

MEd = √𝑀𝐸𝑑𝑦
2 +  𝑀𝐸𝑑𝑧

2  

 

2. Calculate the axial load capacity for concentric loading 
Maximum Axial Compression 
NRd = (η.fcd).(Ag-Ast) + fyd.Ast                                                   (2.9) 

where, 

NRd is Axial load (compression) capacity for concentric loading 

η is the factor for effective strength of concrete 

fcd is design strength of concrete as mentioned in Section 2.1.3  

Ag is the gross area of column Ag = b . h 

Ast is the total area of steel in column. 

fyd is design yield strength of steel as mentioned in Section 2.1.3  

 
Maximum Axial Tension 
NRdt = -fyd . Ast                                                              (2.10) 

where, 

NRdt is Axial Load (Tension) Capacity for concentric loading 

fyd design yield strength of steel 

Ast is the area of steel 
 
3. Compute capacity of concrete stress block. 

Height of compression zone 
X is the height of the compression zone. For the first trial, the balanced failure is assumed hence 
X=cb. 

cb = 
𝜀𝑐𝑢

𝜀𝑐𝑢+𝜀𝑠
d Ast                                                             (2.11) 

where, 

cb is the depth of neutral axis for section failing in balanced condition 

d is the distance of extreme compression fiber from farthest reinforcement 
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[Figure 2.14] Stress strain distribution in concrete column w ith eccentric axial load 

 
Effective height of compression zone 
a = λ . X Ast                                                            (2.12) 

where, 

λ is the factor for effective height of compression zone. 

Acom is the effective area of concrete in compression. It is calculated based on a.  
 

Compression Force in Concrete 
Cc = η x fcd x Acom  Ast                                                    (2.13) 

 
Moment due to compression force 

MRdCy = Cc . DCcz                                                         (2.14) 
MRdCz = Cc . DCcy                                                          (2.15) 

where, 

DCcy is distance of centroid of compression zone from geometric center of 

section along y-axis 

DCcz is distance of centroid of compression zone from geometric center of 

section along z-axis 

 
4. Compute capacity of reinforcement 

Fsi is force of the ith reinforcement 

Fsi = Asi . fsi                                                              (2.16) 
where, 

fsi is stress in the ith reinforcement 









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ydsyd

ydsss

s f

E
f




 

where, 

εsi is strain in the ith reinforcement 

At the extreme compression fiber of concrete, strain equal to εcu is 

assumed. Then the strain is calculated at the center of reinforcement 

assuming a linear stress strain distribution as shown in Figure 2.14. 

Asi is the area of the ith rebar 

Moment due to force in rebar 
i . About the element local y-axes 

MRdNyi = Fsi x dzi                                                          (2.17) 

ii . About the element local z-axes 
MRdNzi = Fsi x dyi                                                          (2.18) 
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where, 

dzi is distance of ith reinforcement from the geometric center of the section 

in the element local z-axis (as shown in Figure 2.14) 

dyi is distance of ith reinforcement from the geometric center of the section 

in the element local y-axis (as shown in Figure 2.14) 

 
Cumulative axial force and moment resistance 
Axial force and the moment due to all  the rebars  are calculated as follows: 

Ns = Σ (Fsi) 

MRdNy = Σ (MRdNyi) 
MRdNz = Σ (MRdNzi) 

 
5. Compute capacity (NRd,MRd) of the section 

NRd  = Cc + Ns  dyi                                                            (2.19) 

MRdy = MRdCy + MRdNy 
MRdz = MRdCz + MRdNz 

MRd = √𝑀𝑅𝑑𝑦
2 + 𝑀𝑅𝑑𝑧

2  

6. Compare the eccentricity with the actual eccentricity 
Eccentricity 

ec = MRd/NRd 
Actual eccentricity 

e = MEd/NEd 

If ec = e, then X is the height of the compression zone. For the first trial ec = eb (balanced 
eccentricity). 
Otherwise new depth is assumed. 
Then new value of X is assumed as follow: 

e < eb, then section is compression controlled and larger value of x is assumed. 
e > eb, then section is tension controlled and smaller value of x is assumed. 

 
[Figure 2.15] Comparison of Tension Controlled and Compression Controlled Column 

 

7. Check P-M Curve 

The P-M curve is generated for a fixed angle of rotation of neutral axis.  
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[Figure 2.16] 2D PM Interaction Curve 

 

3D PM Curve is generated by changing the angle of rotation of neutral axis as follows: 

 
[Figure 2.17] 3D PM Interaction Curve 

 

The output is given in the form of 2-D P-M Interaction Curve as well as 3-D P-M-M Interaction 
Curve. 
 

Check the ratio 

The following ratios are checked to verify the capacity of the axially loaded member  
(wall/column): 

𝑁𝐸𝑑

𝑁𝑅𝑑

 ≤ 1 

𝑀𝐸𝑑

𝑀𝑅𝑑

 ≤ 1 

𝑀𝐸𝑑𝑦

𝑀𝑅𝑑𝑦

 ≤ 1 

𝑀𝐸𝑑𝑧

𝑀𝑅𝑑𝑧

 ≤ 1 

where, 
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MEd : Design bending moment is chosen for the load combinations which are available as per 
2.1.5. 

MRd : Moment Capacity of the section. 

Depending on the ratio, the results are displayed in various formats box as mentioned in Section 
2.4. 

 

2.2.4 Design Criteria for Rebars 

To choose the size of the rebars that should be used for providing the reinforcement, the 
specifications can be provided in Design criteria for rebars dialog box as shown in Section 2.1.3. 

The stirrup data can also be specified in this dialog box. 

Data can be specified for both wall and column design. 

For wall design the End rebar design method and the spacing of the end rebar can be specified in 
Input Additional Wall Data dialog box as shown below: 

 

 Design > Concrete Design Parameter > Modify Column Rebar Data 

 
[Figure 2.18] Input Additional Wall Data dialog box 

 

2.2.5 Concrete checking for columns & walls 

Concrete Code Checking can be performed for column members & wall members as well. The rebar 
data can be specified for axially loaded members and Ultimate Limit State and Serviceability Limit 
State can be verified based on that rebar data. 

 

2.2.5.1 Rebar Input for Column Checking 

The rebar data for the column can be specified in Modify Column Rebar Data dialog box as shown 
below. 
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 Design > Concrete Design Parameter > Modify Column Rebar Data 

 
[Figure 2.19] Modify Column Rebar Data dialog box 

 

2.2.5.2 Rebar Input for Wall Checking 

The rebar data for the wall can be specified in Modify Wall Rebar Data dialog box as shown below. 
 

 Design > Concrete Design Parameter > Modify Wall Rebar Data 

 

 
[Figure 2.20] Modify Wall Rebar Data dialog box 

2.2.6 Design load combinations 
The specifications in Section 2.1.5 are applied. 
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2.3 Design for Shear 
2.3.1 Requirements 
Shear resistance of the section (VRd) should be greater than the design shear force for the section 

(VEd).  
To satisfy Limit state of Shear Resistance the following condition should be met: 

VEd≤VRd 

 

2.3.2 Calculation of Shear Resistance (VRd) 
If VEd is smaller than the shear resistance of concrete, then shear reinforcement is not required 

and shear resistance is calculated by concrete only. If design shear force exceeds shear resistance 
calculated from concrete then the shear resistance is calculated by shear reinforcement only. 

 

[Figure 2.21] Flow chart to calculate VRd 

 

2.3.2.1 Members not requiring design shear reinforcement 
In member for which VEd≤VRd,c, no shear reinforcement is required. In those members the program 
provides the minimum specified shear reinforcement as per Section 4.1.2 and 4.2.2. 

For such sections, the shear resistance  

VRd = VRd,c  dyi                                                                (2.20) 

For calculating the design shear resistance of concrete, larger of the following two values is 
adopted: 

𝑉𝑅𝑑 ,𝑐 =  [𝐶𝑅𝑑,𝑐 𝑘 (100𝜌𝑙 𝑓𝑐𝑘 )1/3 + 𝑘1𝜎𝑐𝑝 ]𝑏𝑤𝑑                                    (2.21) 

𝑉𝑅𝑑 ,𝑐 =  [0.035 𝑘3/2 𝑓𝑐𝑘
1/2

+  𝑘1𝜎𝑐𝑝 ] 𝑏𝑤𝑑                                        (2.22) 
where, 

CRd,c = 0.18/γc 

𝑘 = 1 +  √200/𝑑  ≤ 2.0 

ρl = Asl/(bwd) ≤ 0.02 

σcp = NEd /Ac, In beam design, σcp is applied as zero since axial force is not 

considered. 

k1 = 0.15 

Asl i s  the area of the tensile reinforcement, which extends ≥ (l bd + d) beyond the section 

cons idered. For beam section, program considers Asl as the area of the tensile reinforcement provided. For 
column sections, the Asl i s used as the Ast/2 i.e half of the area of the longitudinal reinforcement.  

 

2.3.2.2 Members requiring design shear reinforcement 
For the members for which the design shear force exceeds the shear resistance provided by 
concrete, the shear resistance is calculated as the resistance provided by shear reinforcement. 

VRd = VRd,s + Vccd + Vtd 𝑑                                                      (2.23) 

where, 

Vccd :shear component of the force in the compression area, in the case of inclined compression 
chord. 

Vtd : shear component of the force in the tensile reinforcement, in the case of inclined tensile chord. 
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[Figure 2.22] Shear component for members w ith inclined chords 

 

Since, inclined chord is not considered therefore the shear resistance is calculated using shear 
reinforcement only. 

VRd = VRd,s                                                                  (2.24) 

 

Design of shear reinforcement is based on truss model as specified in Section 6.2.3 of EN 1992 -1-

1:2004  

 
      [Figure 2.23] Truss model and notation for shear reinforced members 

 
𝜃 is the angle between the concrete compression strut and the beam axis perpendicular to the 

shear force. α is the angle between shear reinforcement and the beam axis perpendicular to the 
shear force. The program provides the shear reinforcement perpendicul ar to the beam axis. So, α 
= 90o. Any other value of α cannot be specified by the user. 

𝜃 can be specified by user in Concrete Design Code dialog box as explained below: 

 

 Design > Concrete Design Parameters > Design Code … 

 
      [Figure 2.24] Concrete Code Design dialog box 

 

Shear resistance of members with shear reinforcement can be calculated depending on the type 
of shear reinforcement as specified in the table below. 

 

[Table 2.3] VRd,s and VRd,max, Asw,max 

Parameter Formula  Remarks  

VRd,s 𝐴𝑠𝑤  (0.9 𝑑) 𝑓𝑦𝑤𝑑  

𝑠
cot 𝜃 

Asw is cross-sectional area of the shear reinforcement. 

s is the spacing of stirrups. 

fywd is design yield strength of the shear reinforcement. 

ν1 is Strength reduction factor for concrete cracked in shear. 

αcw is Coefficient taking account of the state of the stress in 
the compression chord. αcw is always applied as 1.0 in beam 
design. 

VRd,max 𝑓𝑐𝑑  (0.9 𝑑 𝑏 )

cot 𝜃 + tan 𝜃
 𝛼𝑐𝑤 𝑣1 

Asw,max 0.5 𝛼𝑐𝑤𝑣1𝑓𝑐𝑑  𝑏  𝑠

𝑓𝑦𝑤𝑑

 

 

Using, VRd,s = VEd, spacing s of the shear reinforcement is calculated. 
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VRd,max is the design value of the maximum shear force which can be sustained by the member, 
l imited by crushing of the compression struts. 
Asw/s is calculated and compared with Asw,max/s. 

 

[Table 2.4(a)] Strength reduction factor for concrete cracked in shear, ν1 

National  Annex fywd≥ 0.8fywk 
fywd< 0.8fywk 

fck < 60MPa fck ≥ 60MPa 

Recommended 









250
16.0 ckf

 0.6 5.0
200

9.0  ckf  

Singapore 









250
16.0 ckf

 0.54(1-0.5 cosα) 
= 0.54 

(0.84-fck/200)(1-0.5 cosα) ≥ 
0.5  

= (0.84-fck/200) ≥ 0.5 
[Table 2.4(b)] Strength reduction factor for concrete cracked in shear, ν1 

National  Annex 
fywd≥ 0.8fywk fywd< 0.8fywk 

fck ≤ 70MPa               fck > 70MPa fck < 60MPa               fck ≥ 60MPa 

Italy 0.5 0.7 1
250

ckf 
 

 
 0.7 

5.0
85.0

200
9.0



 ckf

 

 

[Table 2.5] Recommended values of Coefficient αcw 

Condition αcw 

0<σcp ≤ 0.25fcd 1+σcp/fcd 

0.25 fcd <σcp ≤ 0.5fcd 1.25 

0.5 fcd <σcp ≤ 1.0fcd 2.5(1-σcp/fcd) 

 

σcp : The mean compressive stress, measured positive, in the concrete due to the design axial force. In 

beam design, σcp is applied as zero since axial force is not considered. 

 

2.3.3 Design Criteria for Rebars 

Size of the rebar to be used for providing the shear reinforcement can be specified in Design 

Criteria for Rebars dialog box. The number of legs to be used for shear reinforcement can also 
be specified. 

 

 Design>Concrete Design Parameter> Design Criteria for Rebar… 

 
      [Figure 2.25] Design Criteria for Rebars dialog box 
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2.3.4 Shear in Concrete Code Checking 
When Beam Checking or Column checking is performed, then checks for shear are also applied. The 
data for the transverse reinforcement can be specified in the program. The data can be specified in 
Modify Beam Rebar Data, Modify Column Rebar Data and Modify Wall Rebar Data dialog box. Refer 
to section 2.1.4.1, 2.2.5.1 and 2.2.5.2 for the usage of these dialog boxes. The program allows the user 
to specify rebar size, rebar spacing and the number of legs for stirrup. 
For beams the data can be specified for i -end, j-end and the middle section. 
For columns the same data can be specified for the two ends of the member and different data can 
be specified for center of the column. 
 

2.3.5 Design Load Combinations 
The specifications of section 2.1.5 are applied. 

In case the shear reinforcement is required, the governing Load combination for shear design is 
not decided on the basis of the magnitude of the shear force. The governing load combination is 

decided on the basis of the ratio of the shear force and shear capacity. 
Now, if there are two shear forces VEd1 and VEd2 such that VEd1>VEd2. VRd,s (Shear Strength provided 
by steel) and VRd,c (Shear Strength provided by concrete) will  be calculated. If VEd1/VRd,s is less than 
the VEd2/VRd,c, then VEd2 will  be governing load combination for shear design, even if VEd2 is smaller 

of the two shear forces. 
 

2.4 Verification of Design/Check Results 
midas Gen provides the results of design/check in various formats. The following design outputs 
are available. 

 

2.4.1 Design Result Dialog Box 

The design results can be checked in Beam Design Result Dialog/Column Design Result Dialog/  
Wall Design Result Dialog box as shown below. 

 

 Design > Concrete Code Design > Beam Design… 

 
      [Figure 2.26] Beam Design Result dialog box 

 

Similarly, the design results can be checked for column and walls. The dialog box for design results 
of column members can be accessed from Design > Concrete Code Design > Column Design.  
The dialog box for design results of wall can be accessed from Design > Concrete Code Design > 
Wall Design. 

 

 

2.4.2 Design/Check Reports  
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The program provides the results in the following kind of report formats: 

i . Graphic Report 

ii . Detail Report 

iii . Summary Report 

 

 
      [Figure 2.27] Graphic Report for Beam Design 

 

 
[Figure 2.28] Detailed Report for Beam Design 
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[Figure 2.29] Summary Report for Beam Design 
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The serviceability l imit state is verified only when we perform Concrete Code Check. It is not verified 
when Concrete Code Design is performed. 
 

3.1 Serviceability Type Load Combination 
The load combinations specified as Serviceability in the Concrete Design Tab of Load Combinations 
dialog box will be used for serviceability limit state check. The program supports the auto generation of 
the load combinations as per EN 1990:2002. 
 

3.1.1 Definition of Short Term and Long Term Load 

For the purpose of crack control, the Load Cases need to be specified as either short term load or 
long term load. 

 

Depending on the type of the load case, the program classifies the load cases automatically.  
Information regarding the classification of load cases can be viewed/modified in Short/Long term 
Load Case dialog box as shown below. 
 

[Table 3.1] Classification of load based on duration 

Type of load Description 

Long term If the load case is any of the following types, it is classified as long term: 
D: Dead Load 
L: Live Load. 

LR: Roof Live Load. 
IL: Live Load Impact 

Short term If the type of load case is other than specified above, then it will  be 
classified as short term load case 

 

 Design> General Design Parameter > Short/Long term Load Case 

 
[Figure 3.1] Short/Long term Load Case dialog box 

 

If a load combination consists of any of the short term load case then the load combination will be 
classified as short term type. Otherwise it will  be classified as long term type. 

 

3.1.2 Classification of Serviceability type Load Combinations 
EN 1990:2002 classifies the serviceability type load combinations in following three types: 

i . Quasi-Permanent 

ii . Frequent 

iii . Characteristic 
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The load combinations that are auto generated are automatically classified in the above types. The 
information regarding the classification of the load combinations can be viewed/modified in 
Serviceability Load Combination Type dialog box as shown below. 

 

 Design> General Design Parameter > Serviceability Load Combination Type 

   
[Figure 3.2] Serviceability Load Combination Type dialog box 

 

3.2 Serviceability Parameters 
Various parameters should be specified for performing the serviceability l imit state check. The 
default parameters are known to the program. Depending on the national annex selected in 
Concrete Design Code dialog box, the parameters are automatically updated. The parameters can 

be viewed/modified in the program. 
 

 Design> General Design Parameter > Serviceability Parameters 

 
[Figure 3.3] Serviceability Parameters dialog box 
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3.3 Stress Limitation 
The compressive stress in concrete should be limited to avoid: 

i . formation of micro-cracks which might reduce durability 

ii . excessive creep 
The program appl ies the stress checks for both situations. The first step in applying the stress check 
is to determine whether the section is cracked or uncracked for the applicable load cases. The 
section is uncracked if the following criteria is fulfilled: 

 
σc (tension) ≤ σca (tension) 

where, 

σc (tension) = Mu Zbar /Iyy, stress in extreme tension fiber 

Mu is the bending moment for a load combination. 

Zbar is the distance of Neutral Axis from extreme tension fiber. 

Iyy is the moment of inertia. 

Iyy and Zbar are calculated assuming elastic behavior of concrete in an uncracked transformed 
section. 
σca (tension) = max [fctm , (1.6-h/1000)fctm]                                           (3.1) 
 
[Table 3.2] Mean Value of Axial Tensile Strength, fctm 

Condition fctm 

≤ C50/60 0.30fck
2/3 

> C50/60 2.12 ln(1+(fcm/10)) 

 
For column members σc (tension) is calculated considering the axial load and the biaxial bending: 

Σc (tension) = Pu/Ac + (Muy Zbar)/Iyy + (Muz Ybar) /Izz                                      (3.2) 

 
If σc (tension) ≥ σca (tension), then the section is cracked. For cracked sections, the program updates 
the section properties for stress check. 

 

3.3.1 Stress Verification to avoid micro cracking 

EN 1992-1-1:2004 specifies “Longitudinal cracks may occur if the stress level under the characteristic 
combination of loads exceeds a critical value. In the absence of other measures it may be appropriate 
to limit the compressive stress to a value k1fck in areas exposed to environments of exposure classes 

XD, XF and XS” and “Unacceptable cracking or deformation may be assumed to be avoided if, under 
the characteristic combination of loads, the tensile stress in the reinforcement does not exceed k3fyk”. 
Therefore, to fulfi l l these two specification, program applies the stress check for both reinforcement 

as well as concrete. 
The stress verification is performed for characteristic type of serviceability load combinations. After 
determining that whether the section is cracked or not, the appropriate method is applied as 
explained below: 

 

3.3.1.1 Un-cracked Sections 
In order to satisfy the stress check for concrete, the following criteria should be met: 

σc (Comp.) ≤ σca (Comp.) 
 

The stress is calculated at the extreme compression fiber of the section. 
 
σc (Comp.) = Mu*(H-Zbar)/Iyy                                                                                     (3.3) 

where, 

Mu is the bending moment for a load combination. 

(H-Zbar) is the distance of Neutral Axis from extreme compression fiber. 

Iyy is the moment of inertia. 

 
Iyy and Zbar are calculated assuming elastic behavior of concrete in an uncracked transformed 
section. 

For column members σc (Comp) is calculated considering the axial load and the biaxial bending: 
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σc (Comp.) = Pu/Ac + Muy (H-Zbar) /Iyy + Muz (B-Ybar) /Izz                                   (3.4) 
where, 

H is the whole depth of cross-section along z-axis. 

B is the whole width of cross-section along y-axis. 

  
The limiting value of the stress in concrete is calculated as: 

σca (Comp.) = k1fck                                                                                               (3.5) 

 
k1 can be specified in Serviceability Parameters. The following values are automatically adopted: 

 

[Table 3.3] Coefficient k1~ k4 

 k1 k2 k3 k4 

Recommended 0.6 0.45 0.8 1.0 

Italy 0.6 0.45 0.8 0.9 

Singapore 0.6 0.45 0.8 1.0 

The parameter k4 is not used by the program. 

In order to satisfy the stress check for reinforcement, the following criteria should be met: 
σs ≤ σsa 

Stress in reinforcement is  calculated as below: 

σs = Mu*(d-zbar)*n/Iyy                                                           (3.6) 
n is the Long term ratio of modulus of Elasticity. 
The limiting value of the stress in the reinforcement is calculated as: 

σsa = k3fyk                                                                     (3.7) 
k3 can be specified in Serviceability Parameters as defined in Section 3.2. 
For column members, the check is applied only for concrete. The stress in reinforcement is not 
checked. 

 

3.3.1.2 Cracked Sections  
The stresses are calculated for various load cases using the suitable modular ratio and then they are 
added to get the stresses due to the particular load combination. 
The following components are used: 

1. Dead Load Cases 
σc,D = Mu_D*zbar/Iyy 
σs,D = Mu_D *(d-zbar)*n/Icr  (Long term ratio is used) 

2. Live Load Cases 

σc,L = Mu_L*zbar/Iyy 
σs,L = Mu_L *(d-zbar)*n/Icr  (Long term ratio is used) 

3. Other Load Cases 

σc,E = Mu_E*zbar/Iyy 
σs,E = Mu_E *(d-zbar)*n/Icr  (Short term ratio is used) 

where, 

Mu_D is the bending moment for a load combination. 

(Zbar) is the distance of Neutral Axis from extreme compression fiber. 

Icr is the moment of inertia. 

 

Icr and Zbar are calculated assuming elastic behavior of concrete in a cracked transformed section. 
The neutral axis is located by equating moment of areas. Then the I cr is calculated about the neutral 
axis. 

 
Then the stress in concrete are calculated as: 

σc = σc,D + σc,L + σc,E 
σs = σs,D + σs,L + σs,E 

 
For concrete, σc ≤ k1 x fck 
For steel, σs ≤ k3 x fyk 

If a column members is cracked, then this procedure is not carried out for it. 
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3.3.2 Check for linear Creep 

EN 1992-1-1:2004 specifies “If the stress in the concrete under the quasi-permanent loads is less 
than k2fck, linear creep may be assumed. If the stress in concrete exceeds k2fck, non-linear creep 
should be considered. ” After determining whether the section is cracked or not under quasi-

permanent load combinations, the appropriate method is applied as explained below: 

 

3.3.2.1 Uncracked Sections 
Method specified in 3.3.1.1 is used to calculate the compressive stress and the allowable 
compressive stress. 

Quasi-Permanent type of combinations are used. 
The allowable stress is calculated as σca (comp.) = k2 x fck. 
If σc (comp.) ≤ σca (comp.) and σs (comp.) ≤ σsa (comp.) then linear creep may be assumed. 
 

3.3.2.2 Cracked sections 
Method specified in 3.3.1.1 is used to calculate the compressive stress and the allowable 

compressive stress. 
Quasi-Permanent Type of combinations are used. 
The allowable stress is calculated as σca (comp.) = k2 x fck. 
If σc (comp.) ≤ σca (comp.) and σs (comp.) ≤ σsa (comp.) then linear creep may be assumed. 

If the column member are cracked, then this procedure is not carried out for them. 
 

3.4 Crack width 
For beam sections, cracking shall be l imited to satisfy the following condition. 

Crack width, wk ≤ Crack width limit, wmax 

Crack width is only calculated if the stress in concrete at the extreme tension fiber exceeds the 
allowable tension stress. 
 

3.4.1 Calculate crack widths 
The crack width is calculated using the following formula: 

wk = Sr,max (εsm –εcm)                                                                   (3.8) 

1. Determine εsm-εcm 
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where, 

εsm The mean strain in the reinforcement under the relevant combination of loads, including 

the effect of imposed deformations and taking into account the effects of tensile 
stiffening. 

εcm The mean strain in the concrete between cracks. 

σs The stress in the tension reinforcement. 

αe Es/Ecm. 

k t A factor dependent on duration of the load. 

 

[Table 3.4] Factor kt 

Condition kt 

Short term loading 0.6 

Long term loading 0.4 
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Ap’ : The area of pre or post-tensioned. Since the tendon is not considered in program, Ap’ =0.  

Ac,eff : The effective area of concrete in tension, bw x hc,ef. 

ℎ𝑒,𝑒𝑓𝑓 = min [2.5(ℎ − 𝑑),
ℎ−𝑥

3
,

ℎ

2
]                                                    (3.11)

 

 

[Figure 3.5] Calculation of Effective tension area 

 

2. Determine sr,max 
The maximum crack spacing, sr,max is calculated as shown in the table below.  

1 2 4
.max 3

,

r

p eff

k k k
s k c




                                            (3.12) 

where, 

ɸ is bar diameter. In case different sizes are used, ɸeq should be calculated as:                                  

 
The program uses the ɸ of the outer layer. 

c is cover to the longitudinal reinforcement. 

k1 : A coefficient accounting the bond properties of rebar (0.8 for high bond bars) 

k2 : Coefficient accounting for distribution of strain. (0.5 for bending) 

k3 : 3.4 (recommended values) 

k4 : 0.425(recommended values) 

These values can’t be changed. 

 

3.4.2 Limiting Crack Width, wmax  

For reinforced members without prestressing tendon, l imiting values of crack width, wmax, are given 
in the table below. 

[Table 3.5] Limiting Crack Width, wmax 

Exposure 
Class  

Serviceability Load combination Type 

Quasi-Permanent Frequent Characteristic 

X0 0.4 User defined  
 
 
 

 
 

Not Checked 

XC1 

XC2 0.3 

XC3 

XC4 

XD1 0.3 

XD2 

XD3 

XS1 0.3 

XS2 

XS3 

XF1* Not Checked  
 
 
 

0.2 

XF2* 

XF3* 

XF4* 

XA1* 

XA2* 

XA3* 
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3.4.2.1 Exposure Class 
Exposure class can be specified in Serviceability Parameters as mentioned in Section 3.2. 

 

3.5 Deflection Check 
EN 1992-1-1:2004 specifies to apply deflection check for certain sections that do not meet the 

depth/span ratio criteria. But midas Gen calculates the deflection for all  the members and compares 
the deflection with the allowable value irrespective of the span/depth ratio. 

There is no deflection check for the complete structure. Deflection check is applied for each member 
separately. 

Deflection verification is performed by comparing the relative deflection of the member to 
deflection limit. Deflection is verified for Quasi-permanent and Characteristic load combinations. 
The limit value is specified by the user in Serviceability Parameter dialog box. 

 

3.6 Verification of Results 
The checking results can be checked in various formats in midas Gen.  

3.6.1 Check Result dialog box 
The checking results can be checked in Beam Checking Result Dialog box as shown below. 

 

 Design > Concrete Code Check > Beam Checking… 

 
[Figure 3.6] Beam Checking Result dialog box 

 

Similarly, the checking results can be checked for column sections  and walls. The dialog box for 

checking results of column members can be accessed from Design > Concrete Code Check > Column 
Checking.  The dialog box for checking results of walls can be accessed from Design > Concrete 
Code Check > Wall Checking. 

 

3.6.2 Design/Check Reports  
The program provides the results in the following kind of report formats: 

i . Graphic Report 

ii . Detail Report 

iii . Summary Report 
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[Figure 3.7] Graphic Report for Beam Checking 

 
 

 
[Figure 3.8] Detail Report for Beam Checking 

 

 

 
[Figure 3.9] Summary Report for Beam Checking 
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When the program provides the reinforcement to the section, then checks are applied for minimum 
and maximum allowable area of steel. Minimum areas of reinforcement are given in order to 
prevent a brittle failure, wide cracks and also to resist forces arising from restrained actions. Along 

with that the program also applies the checks for the spacing of the rebars. There should be 
sufficient space between the resulting bars of members to allow access for vibrators and good 
compaction of the concrete. The details of these checks are discussed in this section. 
 

4.1 Detailing rules for Beam Design 
4.1.1 Longitudinal Reinforcement 
The following specifications of EN1992-1-1:2004 are considered by the program while providing the 
reinforcement. 

Maximum area of longitudinal reinforcement is calculated as: 
As,max = 0.04 Ac                                                                (4.1)                                

 
Minimum area of longitudinal reinforcement is calculated as: 

As,min = 0.26
𝑓𝑐𝑡𝑚

𝑓𝑦𝑘
 btd ≥ 0.0013btd                                                 (4.2) 

where, 

bt denotes the mean width of the tension zone. For rectangular sections, b t is equal 

to section width. For a T-beam width of web is used by the program. 

fctm is taken as specified in 3.1. 

 
For providing the adequate spacing in the bars, the program takes care of the following code 
specifications: 

The clear distance (horizontal and vertical) between individual parallel bars or horizontal layers of 
parallel bars should be not less than the maximum of: 

i . k1⋅bar diameter 

ii . (dg + k2 mm) where dg is the maximum size of aggregate. 

iii . 20 mm 
The recommended values of k1 and k2 are used which are specified as 1 and 5 mm respectively. 
 

4.1.2 Shear Reinforcement 

Minimum required shear reinforcement is calculated by the program as below: 
 

ρw,min = 0.08 √𝑓𝑐𝑘 /𝑓𝑦𝑘                                                          (4.3) 

where, 

ρw is the shear reinforcement ratio 

 
The maximum longitudinal spacing between shear assemblies is taken as the minimum of: 

s l,max = 0.75d (1 + cot α) = 0.75d (for α=90o)                                        (4.4) 

s = Asw / (bw . ρw,min)                                                            (4.5) 

where, 

Asw is the area of shear reinforcement within length s 

s is the spacing of the shear reinforcement 

bw is the breadth of the web of the member 

α is the angle between shear reinforcement and the longitudinal axis. It is applied 

as 90o in midas Gen. 

 
To consider constructability, the program rounds off the required spacing to the lower 10 mm value. 
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4.2 Detailing Rules for column design 
4.2.1 Longitudinal Reinforcement 

EN 1992-1-1:2004 specifies that longitudinal bars should have a diameter of not less than φmin. 

Varying values of φmin are specified in National Annexes. 

This needs to be taken care by the user. When specifying the design criteria for rebars in Design > 

Concrete Design Parameter > Design Criteria for Rebars, the bars bigger than φmin in diameter 

should be chosen by the user. 
 
The minimum allowed amount of longitudinal reinforcement for a column is specified as greater 

of the two values. 

i. As,min = 0.10 NEd/fyd 

ii . 0.002 Ac 
 

The maximum value of amount of longitudinal reinforcement is specified as As,max. The 
recommended value of As,max is 0.04 Ac. 
 
The value of As,max can be viewed/modified in Limiting Maximum Rebar Ratio dialog box as shown 

below: 
 

 Design > Concrete Design Parameters > Limiting Maximum Rebar Ratio 

 
[Figure 4.1] Limiting Maximum Rebar Ratio dialog box 

 

4.2.2 Shear Reinforcement 

For column members, the diameter of the transverse reinforcement should not be less than, greater 
of the two below: 

i. 6 mm 
ii. ¼ times the maximum diameter of the longitudinal bars  

This needs to be taken care by the user. When specifying the design criteria for rebars in Design > 

Concrete Design Parameter > Design Criteria for Rebars, the suitable bar diameter should be 
chosen. 
 
In case the shear reinforcement is not required, the minimum reinforcement is provided as: 

ρw,min = 0.08 √𝑓𝑐𝑘 /𝑓𝑦𝑘                                                             (4.6) 

s = Asw / ρw. bw . sinα                                                           (4.7) 

The s is calculated and used for maximum spacing. 
 
The spacing of the transverse reinforcement along the column should not exceed s cl,tmax: 

The recommended value is  the least of the following three distances: 
i . 20 times the minimum diameter of the longitudinal bars 

ii . Lesser dimension of the column 
iii . 400 mm 

This specification is taken care by the program itself. 
To consider constructability, the program rounds off the required spacing to the lower 10  mm value. 
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4.3 Detailing Rules for Wall design 
4.3.1 Vertical Reinforcement 
The maximum amount of the vertical reinforcement should be applied as: 

Asv,max = 0.04 Ac                                                              (4.8) 

The ratio can be viewed/edited in Limiting Maximum Rebar Ratio dialog box as shown in 
previous section. 
The minimum amount of vertical reinforcement should be applied as: 

Asv,min = 0.002 Ac                                                                      (4.9) 
This is the recommended value and it cannot be edited by the user. 

 

4.3.2 Horizontal Reinforcement 

The minimum horizontal reinforcement is provided as per the following specifications: 

ρw,min = max [0.25As,y/Ac, 0.001]                                                  (4.10)     

The maximum spacing of the horizontal reinforcement shall be l imited to minimum of the following: 

I. 2*As,v/(ρw,min hw) 

II. 400 mm 
 
For wall design, the detail ing rules for shear reinforcement are same as that of column design. 
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Eurocode Design of a Multi-story 
RC Building

 Part I – EC2 in Gen

 Part III – ULS Member Design

 Part IV – ULS Member Checks

 Part V – SLS Member Checks

 Part II – Model & Design Parameters
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Eurocode Design of Reinforced Concrete Building 
as per EN 1992-1-1: 2004

Overview
 Eurocode Design of 

Reinforced Concrete Building
 Model

- 6-story Reinforced Concrete 
Building
- Element: Wall, Beam

 Load & Boundary Condition
- Self Weight
- Floor Loads
- Wind Loads
- Seismic Loads
- Supports

 Analysis
- Linear Static Analysis
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 Gen provides automatic design for beam, column and shear wall. 

 Section checking with the given data.

 Ultimate limit state and Serviceability limit state design and/or checking.

 Default load combinations as per Eurocode 2.

 Static wind loads as per Eurocode 1-4: 2005

 Static seismic loads and response spectrum function as per Eurocode 8-1: 2004

 Capacity design as per Eurocode 8-1 can be applied by checking on “Apply EC8:04 
Capacity Design” option in Concrete Design Code dialog box.

 Available Section shapes

 Column: Rectangle, Circular, Hollow circular

Wall: Rectangle

 Beam: Rectangle, T-shape

Note:

Torsion should be checked by the user.

For meshed slab and wall design, we can use Meshed Slab/Wall Design function.

Reinforced Concrete Design Features in midas Gen

Fundamentals

MIDAS Information Technology Co., Ltd.

midas Gen Tutorial Eurocode Design of Multi-story RC Building
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Ultimate Limit State (ULS) Design

(1) Bending without axial force

Assuming     and      have been determined:
where:

where:
= Moment Redistribution Ratio(Factor)

2/ ckK M bd f
20.598 0.18 0.21K     

K K 

1 0 

If                 (singly reinforced)

where:
is area of compression steel (in layer 1).

K K 

1 /s ydA M f z

/yd yk sf f 

0.5[0.5 0.5(1 3.53 ) ] 0.95z d K d   

1sA
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If              (Doubly Reinforced)

where:
is area of compression steel (in layer 2).

where:
is effective depth to compression steel.

For Minimum and Maximum Required Rebar Area

K K 

2 2( ) / ( )s scA M M f d d  

2sA

2
ckM K bd f 

2700( ) /sc u u

sc yd

f x d x
f f

 


2d
( 0.4)ux d 

1 2/ /s yd s sc ydA M f z A f f 

,min 0.26( / ) 0.0013s ctm yk t tA f f b d b d 
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(2) Bending with axial force
Slenderness Ratio
Second order effects may be ignored if the slenderness λ is below a certain value λlim.

Design Bending moment

where:
is design moment.

is equivalent first order moment including the effect of imperfection(at about mid   
height) and may be taken as =      .
where:

is first order end moments at ULS including allowances for imperfections. 
; nominal second order moment in slender column

0 /l i 

lim 20 /A B C n    

0 2 02 01 2max[ , , 0.5 ]Ed EdM M M M M M  

EdM

0 E dM

0eM

0 02 01 02(0.6 0.4 ) 0.4eM M M M  

02 01,M M
02 01M M

2 2EdM N e
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Capacity - Axial force and uni-axial bending moment
The combinations of  and  that cause failure of a given column section are illustrated by an interact
ion diagram as shown below. 
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Pure compression, point ①

Buckling failure is not considered.
Pure tension, point ②

Balanced failure, point ③
The load and moment at balanced failure,       and        , can be calculated by substituting             
and           into the above equations.

Where,          λ=0.8 for  fck ≤ 50MPa
λ=0.8-(fck-50)/400 for  50 < fck ≤ 90MPa
λ=0.7 for  fck > 90MPa

( )o cd g st st ydP f A A A f  

o st ydP A f 

bP bM s ydf f

b 

0.003
0.003

s
b

yd s

E d
f E

 

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For symmetrically reinforced members, the loads and moments at the points ④~⑪ may be calcul
ated by the formula below.

' '
u cd s s s sP f xb A f A f   

' ' '( 0.5 ) ( ) ( )
2 2 2u cd s s s s

h h h
M f xb x A f d A f d       
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(3) Shear
 Shear resistance of a member with shear reinforcement is equal to:

In regions of the member where VEd ≤VRd,c no calculated shear reinforcement is necessary. 
In regions where VEd > VRd,c sufficient shear reinforcement should be provided in order that         
VEd ≤VRd.

Members not requiring design shear reinforcement

With a minimum of 

Members requiring design shear reinforcement
The shear resistance, VRd is the smaller value of:

and

,Rd Rd sV V

1/ 3
, , 1 1[ (100 ) ]Rd c Rd c ck cp wV C k f k b d  

, min 1( )Rd c cp wV v k b d 

, ( / ) cotRd s sw ywdV A s zf 

,max 1 /(cot tan )Rd cw w cdV b z f    
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Serviceability Limit States (SLS) Design
(1) Stress Limitation
The compressive stress shall be limited to a value k1fck in order to avoid longitudinal cracks und
er the characteristic combination of loads. A value of K1 can be defined by the user and default v
alue is ‘0.6’.

If the stress in the concrete under the quasi-permanent loads is less than k2fck, linear creep may b
e assumed. If the stress in concrete exceeds k2fck, non-linear creep should be considered. A valu
e of K2 can be defined by the user and default value is ‘0.45’.

Unacceptable cracking or deformation may be assumed to be avoided if, under the characteris
tic combination of loads, the tensile stress in the reinforcement does not exceed k3fyk. A value of K
3 can be defined by the user and default value is ‘0.8’.

Where the stress is caused by an imposed deformation, the tensile stress should not exceed k4fyk. 
A value of K4 can be defined by the user and default value is ‘1.0’.
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(2) Crack Control
A limiting calculated crack width, wmax, taking into account the proposed function and nature of the 
structure and the costs of limiting cracking, should be established. 

(3) Deflection Control
The appearance and general utility of the structure could be impaired when the calculated sag of a be
am, slab or cantilever subjected to quasi-permanent loads exceeds span/250.
For the deflection subjected to characteristic loads can be checked by user defined limit. Default limi
t is Span/250. 
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 Beam section size (b, h)

 Cover to rebar center 

 Bar size

Main rebar: Up to 5 sizes simultaneously selected, which GEN will use 
to find the most appropriate.

 Stirrup/Link: One size can be selected.

 P5, P6, P7, P8, P9, P10, P11, P12, P13, P16, P20, P25, P32, and P40 are 
available.

 Arrangement (= Number of legs of the transverse or shear reinforcement)

 Only one case can be selected among the numbers from 2 to 20.

  mmmmhdefault 2.76,5.63,10maxmin

Beam detailing

The following data are required to be input for Beam design:
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 Maximum rebar ratio of main rebar, EN 1992-1-1 9.2.1.1

 Minimum rebar ratio of main rebar, EN 1992-1-1 9.2.1.1

 Minimum spacing (= clear distance) of bars, EN 1992-1-1 8.2

 Maximum stirrup spacing, EN 1992-1-1 9.2.2

Beam detailing
The following conditions are applied to Beam design:

cs AA 04.0max, 

 dbdbffA ttykctms 0013.0,26.0maxmin, 

 mmmmdD gbar 20,5,max 

    cot175.0,min min,max  dbAS wwsw ykckw ff08.0min, 
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Main rebar

 Required rebar area satisfying minimum bar spacing

 Number of bars at top and bottom satisfying minimum bar spacing

 Capacity ratio at I-end, middle, and J-end of beam member

 Up to two layers of rebar can be designed

Stirrups/Links

 Required rebar area per unit length

 Spacing of stirrups

 Capacity ratio at I-end, middle, and J-end of beam member

 Check for crushing of compression struts

Beam detailing
The following are the Design results provided by Gen:
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 Column section size (b, h)

 Cover to rebar center 

 Bar size

Main rebar: Up to 5 sizes simultaneously selected, among which GEN 
will find the most appropriate.

 Tie/Spiral: One size can be selected.

 P5, P6, P7, P8, P9, P10, P11, P12, P13, P16, P20, P25, P32, and P40 are 
available.

 Arrangement (= Number of legs of the transverse reinforcement)

 Different number of legs can be applied in the y and z direction.

  mmmmhdefault 2.76,5.63,10maxmin

Column detailing
The following data are required to be input for Column design:
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 Maximum rebar ratio of main rebar, EN 1992-1-1 9.5.2

, which can be modified.

 Minimum rebar ratio of main rebar, EN 1992-1-1 9.5.2

 Minimum spacing (clear distance) of bars, EN 1992-1-1 8.2

 Maximum stirrup spacing, EN 1992-1-1 9.5.3 & 9.2.2

The maximum spacing is reduced by a factor 0.6 at the i and j-end

of  the column.

Column detailing
The following conditions are applied to Column design:

cs AA 03.0max, 

 cydEDs AfNA 002.0,10.0maxmin, 

 mmmmdD gbar 20,5,max 

  min,max, ,400,,,20min wwswbartcl bAmmhbDS  ykckw ff08.0min, 
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Column detailing
The following are the design results provided by Gen:

Main rebar

 Number of bars satisfying minimum bar spacing

 Capacity ratio for the most critical part among I-end, middle, and J-end 
of column member

 Biaxial P-M interaction diagram

Note. Two layers of rebar or bundle bars are not applicable.

Stirrup/Links

 Required rebar area per unit length

 Spacing of ties/spirals

 Capacity ratio for the most critical part of column member (I-end, 
middle, and J-end)

 Check for crushing of compression struts
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 Wall section size (L, h)

 Cover to rebar center 

 Bar size

 Vertical rebar: Up to 5 sizes simultaneously selected, among which GEN 
will find the most appropriate.

 End rebar: One size can be selected, then program will find the most 
appropriate, greater than or equal to the one selected.

 Horizontal rebar: One size can be selected.

 P5, P6, P7, P8, P9, P10, P11, P12, P13, P16, P20, P25, P32, and P40 are 
available.

 Spacing of vertical rebar

 Select as many spacings as you want program to try

 Spacing of horizontal rebar

 Design method

mmdefault 8.50

Shear Wall detailing
The following data are required to be input for Shear Wall design:
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 Maximum rebar ratio of vertical rebar, EN 1992-1-1 9.6.2

, which can be modified.

 Minimum rebar ratio of vertical rebar, EN 1992-1-1 9.6.2

 Maximum spacing of horizontal rebars, EN 1992-1-1 9.6.3

Shear Wall detailing
The following conditions are applied to Shear Wall design:

cs AA 04.0max, 

cs AA 002.0min, 

  mmhAS vvs 400,2min min,,max   001.0,25.0max ,min, cvsv AA
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Shear Wall detailing
Followings are the design results provided by Gen:

Vertical rebar

 Spacing of vertical rebar

 Capacity ratio for the most critical part among top and bottom of wall

 Uniaxial P-M interaction diagram

Horizontal

 Required rebar area per unit length

 Spacing of horizontal rebar

 Capacity ratio for the most critical part among top and bottom of wall

 Check for crushing of compression struts
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PART II - Contents

The Model File
Performing the Analysis
Design Parameters
ULS Design
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Typical Floor Plan
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Typical Sectional Elevation
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Opening the Pre-generated Model File

1. File > Open Project…

2. Select “EC2 Design”.

3. Click [Open] button.2

3

 This tutorial is intended to illustrate 
design procedure as per Eurocode2. 
Therefore, the geometry creation, boundary 
assignment, load application will be skipped. 
For the aforementioned, refer to “Seismic 
Design for RC Building” tutorial. 

Analysis

1. Analysis > Perform Analysis

 In this tutorial, slab is not included in the 
model and considered as a rigid diaphragm.
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Parameters for ULS Design

• Load Combinations

• Design Code

• Sway Frame Definitions                                                                                                       

• Member Assignment 

• Live Load Reduction Factor Modifications

• Unbraced Lengths (L, Lb)

• Partial Safety Factors

• Concrete and Rebar Properties 
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Load Combinations

5

41. Results > Combinations…

2. Click on “Concrete Design” tab.

3. Click [Auto Generation…] button. 

4. Option: Add

5. Code Selection: Concrete

6. Design Code: Eurocode2:04

7. Click [OK] Button.

8. Click [Close] Button.

7

5

3

2

6

8

 The program 
automatically creates 
design load 
combinations which 
can be also modified or 
deleted by the user.
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Design Code

1. Design > Concrete Design Parameter > Design 
Code…

2. Design Code: Eurocode2:04

3. Click [OK] button.

Sway Frame Definitions

2

3

1. Design > General Design Parameter > 
Definition of Frame…

2. X-Direction of Frame: Braced | Non-sway

3. Y-Direction of Frame: Braced | Non-sway

4. Design Type: 3-D 

5. Check off “Auto Calculate Effective Length 
Factors”.

6. Click [OK] button.

5
6

4

 In the non-sway frame, applying 1 for the 
effective length factor will give conservative 
results.

2

3



15

CHAPTER 3. RC Design Tutorial

Fundamentals

MIDAS Information Technology Co., Ltd.

midas Gen Tutorial Eurocode Design of Multi-story RC Building

29

Member Assignment

3

1. Design > General Design Parameter > 
Member Assignment…

2. Assign Type: Automatic

3. Selection Type: All

4. Click [Apply] button.

5. Click [Close]  button.2

3

4

 A single Member can be 
assigned when the member 
is consisted of a number of 
beam elements. 
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Live Load Reduction Factors (1)

2

3

1. Design > General Design 
Parameter > Modify Live Load 
Reduction Factor…

2. Option: Add/Replace

3. Reduction Factor: 0.82

4. Applied Components: All Forces

5. View > Select > Identity…

6. Select Type: Story

7. Select “1F”

8. Click [Add] button.

9. Click [Close] button.

10. Click [Apply] button.

6

4

1. Reduction factor for 1st floor 
columns and walls. 

EN 1991-1-1 6.3.1.2 (11)

7

1

8

9

10

  82.022 0 



n

n
n



5n 7.00 
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Live Load Reduction Factors (2)

2

3

1. Design > General Design 
Parameter > Modify Live Load 
Reduction Factor…

2. Option: Add/Replace

3. Reduction Factor: 0.85

4. Applied Components: All Forces

5. View > Select > Identity…

6. Select Type: Story

7. Select “2F”.

8. Click [Add] button.

9. Select “Floor”.

10. Click [Delete] button.

11. Click [Close] button.

12. Click [Apply] button.

6

4

7

1

8

9

12

1. Reduction factor for 2nd floor 
columns and walls. 

  85.022 0 



n

n
n



4n 7.00 

10

11

Fundamentals

MIDAS Information Technology Co., Ltd.

midas Gen Tutorial Eurocode Design of Multi-story RC Building

32

Live Load Reduction Factors (3)

2

3

1. Design > General Design 
Parameter > Modify Live Load 
Reduction Factor…

2. Option: Add/Replace

3. Reduction Factor: 0.9

4. Applied Components: All Forces

5. View > Select > Identity…

6. Select Type: Story

7. Select “3F”.

8. Click [Add] button.

9. Select “Floor”.

10. Click [Delete] button.

11. Click [Close] button.

12. Click [Apply] button.

6

4

7

1

8

9

12

1. Reduction factor for 3rd floor 
columns and walls. 

  9.022 0 



n

n
n



3n 7.00 

10

11
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1. Design > General Design Parameter > Unbraced 
Length(L, Lb)…

2. Option: Add/Replace

3. Unbraced Length – Ly: 0 mm

4. Lz: 0 mm

5. Laterally Unbraced Length: Check on “Do not consider”.

6. View > Select > Select All

7. Click [Apply] button.

Unbraced Lengths (L, Lb)

2

3, 4

5

7

1. If “0” is entered for Ly and Lz, 
unbraced lengths will be calculated by the 
program based on the nodal coordinates of 
the beam elements. 

1
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Partial Safety Factors

1. Design > Concrete Design Parameter > Partial 
Safety Factors for Material Properties…

2. Click [Update By Code] button.

3. Click [OK] button.

2

3
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Concrete and Rebar Properties

1. Design > Concrete Design Parameter > Modify 
Concrete Materials…

2. Select “C30/37” from Material List.

3. Rebar Selection – Code: EN04(RC)

4. Grade of Main Rebar: Class B

5. Grade of Sub-Rebar: Class A

6. Click [Modify] button.

7. Click [Close] button.

2

3

4, 5

6 7
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Design Criteria for Rebar (1)

1. Tools > Preferences…

2. Click on “Design”.

3. Concrete – Design Code: Eurocode2:04

4. Rebar – Material Code: EN04(RC)

5. Click [OK] button.

5

2

3

4



19

CHAPTER 3. RC Design Tutorial

Fundamentals

MIDAS Information Technology Co., Ltd.

midas Gen Tutorial Eurocode Design of Multi-story RC Building

37

Design Criteria for Rebar (2) – Beam Design

6. Design > Concrete Design Parameter > Design Criteria 
for Rebar…

7. For Beam Design – Main Rebar: click [Rebar…] button.

8. Select P20 and P25.

9. Click [OK] button.

10. Stirrups: P10, Side Bar: P12

11. Arrangement: 2

12. dT: 55 mm, dB: 55 mm

13. Option of Spliced Bars: None 

11

7

9

8

12

13

10
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Design Criteria for Rebar (3) – Column Design
14. For Column Design – Main Rebar: click 

[Rebar…] button.

15. Select P25 and P32.

16. Click [OK] button.

17. Ties/Spirals: P10

18. Arrangement: X: 2, Z: 2

19. do: 55mm

20. Option of Spliced Bars: None 

20

14

16

15

19 18
17
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Design Criteria for Rebar (4) –Wall Design

21. For Shear Wall Design – Vertical Rebar: click 
[Rebar…] button.

22. Select P13 and Click [OK] button.

23. Horizontal Rebar: P13, End Rebar From: P10

24. de: 45 mm, dw: 45 mm

25. Click [Input Additional Wall Data…] button.

26. End Rebar Design Method: Method-1

27. Click [OK] button.

28. Click [OK] button.

21

28

24

23

25

26

27
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ULS Design 

Concrete Beam Design

Section for Design

Concrete Column Design

Concrete Wall Design

1. The “Section for Design” function provides Member 
design of concrete sections based on the section data defined 
by the user. It allows you to find the appropriate section 
without re-analysis.

1
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Concrete Beam Design (1)

2

1. Design > Concrete Code Design > Beam Design…

2. Sorted by: Member

3. Click           to expand the dialog box.

4. SEL: select MEMB “1”.

5 3

4

76
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Concrete Beam Design (2)

5. Click [Graphic…] button.
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Concrete Beam Design (3)

6. Click [Detail…] button.
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Concrete Beam Design (4)
7. Click [Summary…] button.
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Section for Design (1)
1. Design > Concrete Code Design > Beam Design…

2. Sorted by: Property

1. Red N means that negative moment is larger than the 
resistance for the given section .
Red P means that the positive moment is larger than the 
resistance for the given section.1
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Section for Design (2) 3. Design > Section for Design…

4. Select “413 G3” section.

5. Click [Modify] button.

6. Change H from 0.8m to 0.85m and Change B from 
0.6m to 0.65m.

7. Click [OK] button.

8. Click [Close] button.

4

5

6

7

8
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Section for Design (3)

9. SEL: select SECT “413”.

10. Click [Re-calculation] button.

9

10

1. Check results of Section 
413 G1 change to OK.

1
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Concrete Column Design (1)

3

1. Design > Concrete Code Design > Column Design…

2. Sorted by: Member

3. Click           to expand the dialog box.

4. SEL: select MEMB “41”.

4

1. As with Beam we may check [Graphic…], [Detail…] & 
[Summary…] results. 1

5
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Concrete Column Design (2)

6

5. Click [Draw PM Curve…] button.

6. Click [Close] button.

Fundamentals

MIDAS Information Technology Co., Ltd.

midas Gen Tutorial Eurocode Design of Multi-story RC Building

50

Concrete Wall Design (1)

3

1. Design > Concrete Code Design > Wall Design…

2. Sorted by: Wall ID + story

3. Click           to expand the dialog box.

4. SEL: select WID “1” Story “1F”.

2

4

1. As with Beam we may check [Detail…] & 
[Summary…] results. 
2. As with Column we may Draw PM Curve.

5 1

2
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Concrete Wall Design (2)

5. Click [Graphic…] button.
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Manually Entering Rebar and ULS Checking  

Enter Rebar Data using “Design > Concrete Design Parameter > Modify 
Beam/Column/Wall Rebar Data” or “Design > Concrete Code 
Design > Beam/Column/Wall Design > [Update Rebar] button”

1. In this tutorial, “Modify Beam Rebar Data” will only be illustrated. In the same manner, Column and Wall 
Section Data can also be defined.
1. Rebar will be MANUALLY entered  using “Design > Concrete Design Parameter > Modify 
Beam/Column/Wall Rebar Data” 
1. Rebar can be AUTOMATICALLY entered using “Design > Concrete Code Design > Beam/Column/Wall 
Design > [Update Rebar] button” (this is illustrated later).

1
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Modify Beam Section Data (1)
1. Design > Concrete Design Parameter > Modify Beam Rebar 

Data…

2. SECT: check on ID “412”. 

3.Uncheck “Same Main Rebar Size at Top and Bottom” and 
“Same Main Rebar Size At I,M and J” .

4. For Main Rebar at “End(I)”

5. For Top Rebar: in front of “Top”  and “1” : “4”  “P25”

6. Bottom Rebar: In front of “Bot” and “1” :“2” “P20”

7. For Main Rebar at “Center”

8. For Top Rebar: in front of “Top”  and “1” : “2”  “P20”

9. Bottom Rebar: In front of “Bot” and “1” :“4” “P25”

10.For Main Rebar at “Center”

11.For Top Rebar: in front of “Top”  and “1” : “4”  “P25”

12. Bottom Rebar: In front of “Bot” and “1” :“2” “P20”

2

3

9

11
5 8

6
12
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Modify Beam Section Data (2)
13. Stirrup in “End(I)” 

14. Arrangement: “2”

15. Stirrups Space: “100” mm

16. Stirrup in “Center” 

17. Arrangement: “2”

18. Stirrups Space: “200” mm

19. Stirrup in “End(J)” 

20. Arrangement: “2”

21. Stirrups Space: “100” mm

22.Stirrup: “P10”

23. dT, dB : 0.055m,0.055m

24. Click [Add/Replace] Button
14 15 17 18 20 21

22

23
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ULS Beam Member Code Check

6-1. Beam Code Checking

1. In this tutorial, only “Beam Code Checking” will be 
illustrated. In the same manner, Column/Wall Code 
Checking can be performed. 

1
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Beam Code Checking (1) 1. Design > Concrete Code Check > Beam Checking…

2. Sorted by: Member

3. Results: Strength

4. Click            to expand the dialog box.

5. SEL: MEMB “11”

2 3

8
6

5

4
9

7
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Beam Code Checking (2)
6. Click [Graphic…] button.
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Beam Code Checking (3)

7. Option for Detail Print Position: check on “End I.” “Mid.” “End J.”. 

8. Click [Detail…] button
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Beam Code Checking (4)
9. Click [Summary…] button.
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Parameters for SLS Checking

Concrete long-term and short-term Modulus of elasticity 

Serviceability Load Combination

Enter Rebar Data using “Design > Concrete Design Parameter > Modify 
Beam Rebar Data or “Design > Concrete Code Design > Beam 
Design > [Update Rebar] button ” 

Serviceability Limit Control Parameters

1. For serviceability check, entering rebar data is required.

1
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Short/Long Term Elasticity Ratio

1. Design > Concrete Design Parameter > Modify 
Concrete Materials…

2. Select “C30/37” from Material List.

3. Click        button.

4. Click [OK] button.

5. Click [Close] button.

2

3

45
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Serviceability Load Combination Type

2

1. Design > General Design Parameter > 
Serviceability Load Combination Type…

2. Click [OK] button.

 Once the load combinations are generated using 
“Auto Generation” as per Eurocode2 as in Step 3-1, 
the program automatically assigns the “Quasi-
permanent”, “Frequent” and “Characteristic” load 
combinations.
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Automatic Rebar Input

1. Design > Concrete Code Design > Beam Design…

2. SEL: click [Select All] button.

3. Click [Update Rebar] button.

4. Click [Close] button.

2

3

4

1. By clicking [Update Rebar] button, the rebars 
designed in this dialog box will be automatically 
entered into the selected sections. 

1
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View Rebar Data on Section

1. Design > Concrete Design Parameter > Modify 
Beam Rebar Data…

2. SEL: check on ID “413”. 

3. Click [Close] button.

2

3

1. In this page, check the Rebar Data entered 
using [Update Rebar] in the previous page.
2. “In” signifies that Rebar are placed. 
3. The entered Rebar Data are displayed.

2

1

3
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Enter Serviceability Limit Control Parameters 

1. Design > Concrete Design Parameter > 
Serviceability Parameters…

2. Option: Add/Replace

3. Selection Type: By Selection

4. Exposure Class: XD1

5. Stress Parameters- k1: 0.6, k2: 0.45, k3: 0.8, k4: 1

6. Quasi-permanent – Limit: 0.3 mm

7. Quasi-permanent Deflection Ctrl: L/250

8. Characteristic Deflection Control – Limit: L/250

9. Deflection Amplification Factor: 1

10. View > Select > Identity…

11. Select Type: Section

12. Select “411: G1”, “412: G2”, “413: G3”, “414: 
G4”, “415: B1”, “421: WG1”, “422: WG2”

13. Click [Add] Button.

14. Click [Close] Button.

15. Click [Apply] Button.

2

9

14

15

13

12

11

8

7

6

5

4

3
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Serviceability Checking for Concrete Beam

SLS Checks 

1. Serviceability check is provided for Beam members for the following limit states.
- Stress limitation
- Crack control
- Deflection control

1
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1. Design > Concrete Code Check > Beam Checking…

2. Sorted by: Member

3. Results: Serviceability

4. Click          to expand the dialog box.

5. SEL: select MEMB “1”

Serviceability Checking (1)

4

2
3

6

5

7 8
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Serviceability Checking (2)

6. Click [Graphic…] button.
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7. Click [Detail…] button.

Serviceability Checking (3)
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8. Click [Summary…] button.

Serviceability Checking (4)




